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INTRODUCTION
The competency Producing Reports is part of the program of study for a diploma of vocational studies (DVS) in 
Secretarial Studies. The program is divided into 25 competencies representing a total of 1485 hours of training.

Code Number Competency Length (h) Credits

960-501 01 The Occupation and the Training Process 15 1

960-515 02 Proofreading 75 5

960-526 03 Word Processing 90 6

960-534 04 Quality of Written English 60 4

960-544 05 Customer Service 60 4

960-554 06 Document Management 60 4

960-562 07 Producing Spreadsheets 30 2

960-572 08 Designing Presentations 30 2

960-584 09 Business Texts in English 60 4

960-596 10 Accounting Operations 90 6

960-605 11 Business Correspondence 75 5

960-613 12 Producing Databases 45 3

960-623 13 Handling Cash 45 3

960-635 14 Translation 75 5

960-644 15 Producing Tables and Charts 60 4

960-656 16 Visual Design of Documents 90 6

960-666 17 Business Texts in French 90 6

960-672 18 Digital Media 30 2

960-833 19 Interacting in French 45 3

960-695 20 Following Up on Business Correspondence 75 5

960-704 21 Meetings and Events 60 4

960-714 22 Producing Reports 60 4

960-722 23 Technical Support 30 2

960-733 24 Coordinating Multiple Tasks 45 3

960-746 25 Entering the Workforce 90 6

One credit corresponds to 15 hours of training.

V Introduction
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PRESENTATION OF THE LEARNING GUIDE
The specific competency Producing Reports is one of the 25 competencies cov-
ered in the Secretarial Studies vocational program. The educational aims of the 
program are to maintain and promote the quality of English, improve the qual-
ity of customer service, develop learners’ desire to improve their knowledge of 
technological tools, and develop their sense of autonomy and initiative.

Secretaries today are trained to work independently yet play an integral role 
in any management team. They are indispensable assistants to managers and 
professionals, handling a variety of files and assuming multiple responsibilities. 
The competencies required to meet the needs of modern organizations are 
numerous and increasingly varied.

This guide will help you develop your competencies in producing reports. You 
will learn the general characteristics of a report, its components, the manner 
in which to lay out the text and the components, such as headers and footers, 
pagination, citations and notes, tables and charts, appendices and the bibli-
ography, all in accordance with current standards. You will also learn how to 
modify, create, number and manage styles in the Word application. Moreover, 
you will work with Word functions that allow you to update tables quickly and 
efficiently. Instructions come with screen shots so that you can easily grasp the 
various steps to follow when using the Word application. In order to support 
everything you have learned, you will be asked to format two reports as part of 
the scored activities.

WORK SITUATIONS

This learning guide consists of three work situations (WS) that will not only lead 
you to acquire new knowledge but teach you to apply it with ease and use it 
skillfully. Each situation follows the same structure. First, you read about the 
work context and the assignment you must carry out.  Next, you embark on a 
series of engaging and motivating tasks.  You will be guided step by step through 
each task. All of the answers to the exercises can be found in the answer key, at 
the end of the guide.

EVALUATION OF LEARNING

This guide comes with two scored activities, that you can download from the 
portailsofad.com website. You will find all the information you need in your 
guide when you reach the appropriate stage for evaluation.

Scored activities must be submitted for correction and grading. You will hand 
them in to your teacher if you are taking the course in an education centre, or 
you will send them to your tutor if you are registered for distance learning. In 
either case, the corrected document will be returned to you.

Scored activities are an excellent way for you to identify areas of difficulty so 
that you can work to overcome them. The last scored activity in the guide was 
developed following the same criteria as those of the final evaluation for the 
course. It therefore serves as an effective practice test for the official final exam-
ination, which will take place under supervision in an adult education centre.

VI P R O D U C I N G  R E P O R TS
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REQUIRED MATERIALS
The materials for this course include the following:

•	 the learning guide and its answer key

•	 two scored activities

•	 access to the portailsofad.com website

•	 the Report Layout Procedure and Style List reference tool (available on the 
portailsofad.com website) 

•	 documents relating to situations 1, 2 and 3 (available on the portailsofad.com 
website)

RECOMMENDATIONS FOR SUCCESS

We recommend that you do all the exercises in the learning guide as well as the 
two scored activities provided. Carefully compare your answers with the answer 
key and, if necessary, review content to make sure you fully understand it before 
going on to the next task.

If you have questions, do not hesitate to ask your teacher or tutor for explana-
tions.

The course is estimated to take approximately 60 hours to complete. Set up a 
study schedule that takes into account your needs as well as your obligations: 
family, work or other responsibilities. Follow the schedule you have set as 
closely as possible.

VII Introduction

460-714_Guide22_EN.indb   7 19-09-03   17:33



©
 S
O
F
A
D

 -
 R

e
p

ro
d

u
c

tio
n

 p
ro

h
ib

ite
d

.

Initiation to 

Producing  

Reports

1

 
Initiation to Producing  Reports

©
 S
O
F
A
D

 -
 R

e
p

ro
d

u
ct

io
n

 p
ro

h
ib

ite
d

.

Initiation to 
Producing  
Reports

Your Assignment
This is the first week of your practicum at Grazia 
Communications and the Communications manager, 
Luna Sancha, has told you that you will help Vy transcribe  
and lay out the text of a report. You therefore decide to review 
these concepts because several weeks have passed since you 
have exercised your skills related to producing reports.  
You will take advantage of this time to review everything, 
starting with the basic concepts.

Your assignment consists of the following:

1. distinguishing the general characteristics of the report

2. transcribing the text without error

3. laying out the text of a report

Your secretarial training is coming to an 
end and you must now complete it 
with a practicum in an organization. 

Your application was selected at Grazia 
Communications, a company specialized in 
writing and producing all types of 
documents.

Your practicum will take place under the 
supervision of Vy Pham, who has been working 
there as an administrative assistant for a few 
years now. In general, her tasks consist of tran-
scribing and laying out texts. Laying out texts 

inevitably requires formatting, the insertion of 
all the elements essential to documentation 
and, naturally, the addition of the table of con-
tents, the index and sometimes the table of fig-
ures, depending on the scope of the document.

Vy is a resource person with Grazia 
Communications, because she is thorough and 
committed to a job well done. That is the rea-
son why she will be supervising your practicum. 
If all goes well, you may be offered a job after 
the practicum.

P R O D U C I N G  R E P O R TS2 3
 Initiation to Producing  Reports
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1

TOTAL 
DURATION

15 h

The title page presents 
the number and title of 

the work situation.

The situation begins with a 
description of the context in which 
you will complete different tasks to 

acquire the target competency.

The total length 
of all the 

situation tasks 
includes the 

scored activity, 
if applicable.

OVERVIEW OF THE LEARNING GUIDE

Opening Pages

The Your Assignment section 
summarizes and lists the tasks 
you will perform during the 
work situation.

VIII P R O D U C I N G  R E P O R TS
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TASK 1.1

Distinguishing the General Characteristics of the Report
In order to transcribe and lay out the text of a report, you must 

understand the nature of the text and its characteristics. You are 

now taking a few minutes to go over the essential information 

about the reports that Vy has given you.
A  report is an “o� icial or uno� icial, elaborate summary produced by a person 

or an organization that was mandated to do so.1”
The Objectives of the Report

The report presents facts used to inform, explain and present solutions to the 

reader. It must therefore be objective, dra� ed in the a� irmative form and contain 

no judgment or point of view, except in the case of recommendation reports.
Types of ReportsA multitude of types of reports exist such as financial, technical, annual or 

analytical reports, status reports, business or activity plans, memoranda 

presented to the government, evaluation preparation guides, etc.

Reports can be categorized into three groups:
 • analytical reports – aimed at providing understanding of an issue or situation

 • information reports – aimed at providing knowledge

 • recommendation reports – aimed at recommending a particular course of 

action

1. Translated from the French definition from the OFFICE QUÉBÉCOIS DE LA LANGUE FRANÇAISE, 

Banque de dépannage linguistique, [Online], (consulted on April 5, 2018).
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The task number is 
clearly indicated.

Situation Highlights

The following table presents these three categories, their objectives and examples 

of reports associated with each category.

CATEGORIES OF REPORTS
OBJECTIVES

EXAMPLES

Analytical report • Presents the reasoning process

• Allows for the process to be 

repeated for further analysis

• Financial report

• Technical report

• Report on the impact 

of social media

Information report • Details relevant, necessary and 

appropriate facts

• Presents observed and verifiable 

data

• Presents quantified or qualified 

information

• Monthly, quarterly or 

annual report

• Activity report

• Status report

• Communication report

Recommendation report • Leads the reader to adopt the 

ideas expressed in the report

• Presents facts that enable 

comprehension

• Presents the strong points 

of the analysis

• Business plan

• Evaluation preparation 

guide

The report is therefore an essential business tool. Indeed, it allows its readers to 

position themselves with regard to the decisions to be made over the short, 

medium and long term.

5
 I
nitiation to Producing  Reports
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Content is often 
presented in tables 
to make it easier to 

understand.
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Using Page 

and Section 

Breaks

Vy recognizes the importance of properly preparing one’s 

work. In order for you to get o�  to a good start, she wants 

to make sure that you understand the specifics of page 

and section breaks.

The formatting of an administrative document, regardless of the type, is an 

aspect to which particular attention must be paid. This is even more true for a 

report because it could be long and divided into parts (sections) that could run 

on several pages. Proficiency with page and section breaks is therefore important. 

For example, if only one page needs to be printed in Landscape mode, you must 

create a section break for this page.

As a reminder, Vy prepared the table below to help you compare the reasons for 

inserting a section or a page break into a report.

PAGE AND SECTION BREAK CHARACTERISTICS

Section break
Page break

This break is necessary if you must:

• vertically align the text on one page

• add page borders

• modify or add di� erent elements in 

the page header and footer, from one 

section to another

• change a page orientation

• change the margins

• work with columns

• change the page numbering in 

your document

This break is necessary if you must:

• simply change page, without any 

changes from one page to another

TASK 2.1

 Section 

Part or portion of a one- or 

multi-page document with 

its own specific formatting. 

34 P R O D U C I N G  R E P O R TS
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Terms that may be 
difficult to understand 
are defined in the page 
margins. The definitions 
used in the guide are 
inspired in great part by 
the Antidote software.

3  Correct the text of the document Report_1. To help you with this process, here is a checklist to use as a reminder.

ELEMENTS TO CHECK QUESTIONS TO ASK 3
 1.  Sentence structures Are the sentences well structured?

Are the links between the elements adequate?
 2. Grammar Are the verbs properly conjugated?

Are the correct prepositions used? 
 3. Spelling mistakes Are the words properly written?

Are there typos?
 4. Punctuation Do all the sentences have periods?

Are the commas in the right places?

Do the questions have a question mark?
 5. Abbreviations Did I check all the abbreviations?
 6. Capital letters Did I check the forms of address (titles)? The first names? The job titles?
 7. Numbers Should the numbers be written in number form or letter form?
 8. Vocabulary: Gallicisms, 

incorrect expressions, 
imprecise information, 
repetitions and redundancies

Do I have any doubts regarding the use of certain words? Did I take the time to check them?

 9. Clarity and simplicity Is there any information that is missing? Is there too much information?

Are there sentences that are too long?

Will the reader understand all the words that I have used?
 10. Elegance and persuasion Is the language polite and proper?

Is my message elegant, inviting?

Speech Writing Checklist Reminder

Tip
To help you correct texts 
entered on a computer, do not 
hesitate to use the Spelling 
and Grammar function of 
Word or Antidote.

11 Initiation to Producing  Reports
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The Tip feature 
presents practical 

advice to help you do 
an exercise.

The Reminder feature 
refers to concepts 

which you have 
already studied and 

may contain exercises.
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Inserting and 

Formatting the 

Various Elements 

of a Report

Vy reminds you that, for a report to be complete and look professional, 

various elements must be integrated into it, such as figures and tables, 

quotes, notes and references, headers and footers, pagination, 

appendices and bibliographical references.

These various elements, which are o� en inserted in reports to provide specific 

information or to clarify the content, are presented successively according to a 

pre-established order. Regarding bibliographical references, note that several 

models exist although the present guide lists only the most common. 

Furthermore, as you have previously seen, you can add a page entitled 

Webliography if it contains five or more entries. However, this remains optional.

Figures and Tables

The Table of Illustrations lists all drawings, charts, images, schematic drawings, 

tables, etc., that are presented in the report. Using this guide, you will learn how to:

 • lay out the figures1 and the tables in a report

 • add figures and tables in the form of a caption so that they are integrated in 

the Table of Illustrations

 • add figures and tables by creating links

TASK 2.3

1. A figure can be an image, a chart, an illustration or any other form of graphical element.

In many reports or other 

reference works, the 

webliography is not created 

in a separate page, no matter 

how many entries there are. 

Webliographical references 

are then added to the 

bibliography. That is why 

this page remains optional.

N.B.

56 P R O D U C I N G  R E P O R TS
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The N.B. feature 
draws your attention 
to an important 
observation.

2  Using Word, create a cover page for the report on the opinion survey. Enter the information below and lay it out according to the standards.
 • Université du Québec à Trois-Rivières
 • Report on the opinion survey on the sustainable development of tourism in Québec • Report presented to the Department of Studies 
 • Prepared by the Department of Studies in Leisure, Culture and Tourism 
 • In collaboration with the Québec Tourism Ministry and the Department of Evaluation and Strategic Analysis 
 • April 20XX

To obtain the logo of the Québec Tourism Ministry, go to the portailsofad.com site.

 Compare your answers with the ANSWER KEY. 

45 Inserting and Laying Out All the Elements of a Report 
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This pictogram tells you 
that you must use the 

Internet or a computer to 
complete the task.

This pictogram indicates 
that you must download 

documents from the 
portailsofad.com site.

A regularly repeated 
instruction points out 

the best time to compare 
your answers with the 

Answer Key (at the end 
of the guide).
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Inserting a Page Break
The following is how to insert a page break:

1. Place the cursor where you want the page to finish and the next page to start.
2. In the menu bar, click the Layout tab, then Breaks and select Page.

Figure 2.1

To display the page breaks in order to delete them, click the Home tab, then the paragraph symbol.

Figure 2.2

P� a� aph Symb� 

Ergo
Keyboard Shortcuts
Using keyboard shortcuts 
allows you to minimize work 
using the mouse and thereby 
reduces repetitive movements 
on the upper limbs.
The Ctrl + Enter shortcut 
inserts a page break instead of 
a page break character.

35 Inserting and Laying Out All the Elements of a Report 
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The Ergo feature offers 
suggestions of good 
posture and working 
positions to adopt at 
your desk and 
elsewhere in the 
workplace.

Scored Activity 1
You must now complete Scored Activity 1.

Go to the SOFAD site at portailsofad.com and download the 

document entitled Scored Activity 1.

Complete the activity and hand it in to your teacher, or send it to 

your tutor according to the terms provided when you registered.

82 P R O D U C I N G  R E P O R TS
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At the end of Situations 2 and 
3, this pictogram tells you to 

complete a scored activity.
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Initiation to 
Producing  
Reports

Your secretarial training is coming to an 
end and you must now complete it 
with a practicum in an organization. 

Your application was selected at Grazia 
Communications, a company specialized in 
writing and producing all types of 
documents.

Your practicum will take place under the 
supervision of Vy Pham, who has been working 
there as an administrative assistant for a few 
years now. In general, her tasks consist of tran-
scribing and laying out texts. Laying out texts 

inevitably requires formatting, the insertion of 
all the elements essential to documentation 
and, naturally, the addition of the table of con-
tents, the index and sometimes the table of fig-
ures, depending on the scope of the document.

Vy is a resource person with Grazia 
Communications, because she is thorough and 
committed to a job well done. That is the rea-
son why she will be supervising your practicum. 
If all goes well, you may be offered a job after 
the practicum.
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Your Assignment
This is the first week of your practicum at Grazia 
Communications and the Communications manager, 
Luna Sancha, has told you that you will help Vy transcribe  
and lay out the text of a report. You therefore decide to review 
these concepts because several weeks have passed since you 
have exercised your skills related to producing reports.  
You will take advantage of this time to review everything, 
starting with the basic concepts.

Your assignment consists of the following:

1.	 distinguishing the general characteristics of the report

2.	 transcribing the text without error

3.	 laying out the text of a report

3
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TASK 1.1

Distinguishing the  
General Characteristics  
of the Report
In order to transcribe and lay out the text of a report, you must  
understand the nature of the text and its characteristics. You are  
now taking a few minutes to go over the essential information  
about the reports that Vy has given you.

A  report is an “official or unofficial, elaborate summary produced by a person 
or an organization that was mandated to do so.1”

The Objectives of the Report
The report presents facts used to inform, explain and present solutions to the 
reader. It must therefore be objective, drafted in the affirmative form and contain 
no judgment or point of view, except in the case of recommendation reports.

Types of Reports
A multitude of types of reports exist such as financial, technical, annual or 
analytical reports, status reports, business or activity plans, memoranda 
presented to the government, evaluation preparation guides, etc.

Reports can be categorized into three groups:

•• analytical reports – aimed at providing understanding of an issue or situation

•• information reports – aimed at providing knowledge

•• recommendation reports – aimed at recommending a particular course of 
action

1.	 Translated from the French definition from the OFFICE QUÉBÉCOIS DE LA LANGUE FRANÇAISE, 
Banque de dépannage linguistique, [Online], (consulted on April 5, 2018).

P R O D U C I N G  R E P O R TS4

©
 S
O
F
A
D

 -
 R

e
p

ro
d

u
c

tio
n

 p
ro

h
ib

ite
d

.

460-714_Guide22_EN.indb   4 19-09-03   17:34



The following table presents these three categories, their objectives and examples 
of reports associated with each category.

CATEGORIES OF REPORTS OBJECTIVES EXAMPLES
Analytical report •	 Presents the reasoning process

•	 Allows for the process to be 
repeated for further analysis

•	 Financial report
•	 Technical report
•	 Report on the impact  

of social media

Information report •	 Details relevant, necessary and 
appropriate facts

•	 Presents observed and verifiable 
data

•	 Presents quantified or qualified 
information

•	 Monthly, quarterly or  
annual report

•	 Activity report
•	 Status report
•	 Communication report

Recommendation report •	 Leads the reader to adopt the 
ideas expressed in the report

•	 Presents facts that enable 
comprehension

•	 Presents the strong points  
of the analysis

•	 Business plan
•	 Evaluation preparation  

guide

The report is therefore an essential business tool. Indeed, it allows its readers to 
position themselves with regard to the decisions to be made over the short, 
medium and long term.

5
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Here are a few questions to ask yourself to help you determine the type of report 
to present:

•• What is the objective of this report? To inform, analyze or convince?

•• Who is producing this report? An organization, a private company, the 
government?

•• Who is drafting this report? A teacher, a contractor, an employee, a 
representative of a renowned company?

•• Who is this document for? For investors? For the members of a management 
committee? For company shareholders? For engineers?

•• Are there constraints related to the presentation of this report?

You must know the objectives of the report because they will allow you to present 
the content in a clear, fair and professional manner.

	 Indicate the category (information, analytical or recommendation report)  
of the following types of report:

a)	 financial report 	

b)	 business plan report	

c)	 status report 	

d)	 report on the impact of social media 	

e)	 monthly report 	

f)	 activity report 	

 Compare your answers with the ANSWER KEY. 

1
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Transcribing  
Text Without Errors
Upon request from Ms. Sancha, Vy sends you a document for quick  
transcribing. She will pay specific attention to your transcription  
speed as well as the quality of the language used.

The touch-typing method, once widely taught, is no longer considered stan-
dard practice. The focus today is on transcription time. In fact, younger genera-
tions, because of their use of new technologies (including keyboards), are fast 
and comfortable with entering text, even without using the touch-typing method.

Mastering the Transcription Method
Because speed of execution is a considerable asset in the field of administration, 
you should practise for about 15 minutes a day, at a time that is convenient for 
you, in order to maintain a good cadence.

2 	a)	 Using a stopwatch, time your transcription speed by entering the entire text of the two following 
pages using Word. This text contains mistakes, but for the purposes of this exercise, concentrate 
only on the speed of your transcription. You will revise the text in the next question. 

TASK 1.2
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Introduction (Main heading)

One of the first phases of the intervention plan consist of gathering and analyzing 
information. To this effect, several factors must be taken into account: family factors 
that often justify an issue; personal factors that influence an individual’s behaviour; 
and several other factor on which we based ourselves for the purposes of this report. 
Finally, in order to carry out an evaluation of the students, intervention methods are 
presented.

Information gathering and analysis (Title)

In the case of a student with a learnings disability, the instructor will first stdy the 
student’s file. The instructor will examining the student’s file to see if the problem is 
known. Let’s take a look at Jasmine’s case, who is in elementary school in the second 
grade.

Student cases (Subtitle)

Since the beginning of the year, Jasmine has been turning her work in on time, but it 
is often incomplete or riddled with errors. Her teacher, Mrs. Hélène, therefore wanted 
to analyzes her student’s problem more closely. She gave Jasmine a few first grade 
exercises in order to evaluate the breadth of her knowledge. To her great dismay, 
Mrs. Hélène discovered that that Jasmine’s difficulties date back to the previous year 
and that they have not been resolved.

When this type if learnings disability situation presents itself, information gathering 
and analysis must be evaluated as accurately as possible in order to understand the 
student’s reality and determine her real needs. Obviously, the teachers must gather 
information from everyone who is ready to help the student: parents, support staff, 
the child and ideally a few specialists or intervention workers. Together, they must try 
to establish the risk factors. Is there a lack of motivation? How does the child behaves 
in different learning situations? The resource personnels must collaborate together, 
identify these elements and work on them using an intervention plan.

Face to face (Subtitle)

On a blackboard, the teacher presents the problem to the student in order to work 
through the area she is interested in:

•• strengths

•• needs

•• elements to improve

•• elements to develop

The following step consists of communicating at the parents and all of the personnel 
involved. An intervention plan is then created or modified depending on whether this 
is a first experience or a re-evaluation. Communication with a parent is essential. The 
approach used by the staff must, at all times, be established with the greatest of 
respect in order to reassure and involve the parent. The parents’ thoughts as to their 
perception of their child’s difficulties must also be heard and assessed.
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After discussion with the parent, the teacher can review a few aspects of the plan to 
be drafted. For example: the parent mentions that the child does her homework late 
at night in front of the TV. The student had left that detail out. Trivial or not?

Keep in mind that the objective being to develop the expected skills in the child within 
a desired timeframe.

“If we could choose the best strategy for Jasmine, it would be the strategy of reciprocal 
teaching. This strategy, developed by Palinscar and Brown (1984), has helped 
elementary school children since the 80s understand and successfully to solve a 
problem that requires reading. Here, Jasmine has difficulty in reading comprehension 
and mathematics. ”

Risk factors (Subtitle)

Let’s take a look at the systemic vision within which many factors can be found. Let’s 
analyze Jasmine’s personal, family and social aspects.

Family (Sub subtitle)

The teacher also learned that during homework time, Jasmine’s parents are mostly 
or completely unavailable to help her. This is an example that characterizes the 
family’s values. The parents’ previous educational practices influence children a great 
deal. In this case, they unfortunately influence Jasmine negatively.

Social (Sub subtitle)

Socially, Jasmine is a model child. She identifies with younger children as well as older 
children. Her behaviour is exemplary. In class however, the teacher observed that 
Jasmine regularly becomes impatient when faced with a (problem) to solve. One of 
the difficulties Jasmine has is shyness. She therefore needs to work on her courage. 
According to certain specialists, this skill is one of the most difficult to adopt in a child 
her age.

Intervention method (Title)

Planning interventions with the child (Subtitle)

Everyone concerned meets during a meeting to review student cases: the teacher, a 
specialist qualified in the child’s needs, the child and her parents. The teacher 
expresses the child’s priorities in terms of her needs and the team supports these 
statements with facts. The skills to improve have been determined as well as the 
schedule. The same is true for the skills to be developed.

Conclusion (Main heading)

When analyzing a case such as Jasmine’s, it is desired and recommanded to analyze 
the student’s file and produce a realistic intervention plans ideally without undue 
delay. Communication between all those concerned is critical and unavoidable to 
carry out an intervention plan.
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		  What is the time on your stopwatch? If you have transcribed this text in less than 25 minutes, very 
good! You are within the allotted time. If it took you longer than 30 minutes, keep practising.

b)	 Place the texts that have the mention Heading and Title on a new page, in a new section. To do so, 
click Page break in the Format tab, then, under the Section break section of the pop-up menu, 
select Next page.

c)	 Organize all the texts that have the mention Subtitle and Sub subtitle so that they are in keeping 
with the following paragraph. To do so, use the paragraph text flow parameters available in the 
Paragraph group of the Format tab.

	 Save your work under Report_1 and keep your document open.

Checking the Quality of  
the Written English
Text transcription requires you to enter content that has already been written by 
hand or dictated. Sometimes the text may even have already been entered. 
However, you must pay particular attention to the quality of the written English.  
The person who wrote the report could have made a few typos, careless mistakes 
or errors of grammar or punctuation.
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3 	 Correct the text of the document Report_1. To help you with this process, here is a checklist to 
use as a reminder.

ELEMENTS TO CHECK QUESTIONS TO ASK 3

	 1. 	Sentence structures Are the sentences well structured?
Are the links between the elements adequate?

	 2.	 Grammar Are the verbs properly conjugated?

Are the correct prepositions used? 

	 3.	 Spelling mistakes Are the words properly written?

Are there typos?

	 4.	 Punctuation Do all the sentences have periods?

Are the commas in the right places?

Do the questions have a question mark?

	 5.	 Abbreviations Did I check all the abbreviations?

	 6.	 Capital letters Did I check the forms of address (titles)? The first names?  
The job titles?

	 7.	 Numbers Should the numbers be written in number form or letter form?

	 8.	 Vocabulary: Gallicisms, 
incorrect expressions, 
imprecise information, 
repetitions and redundancies

Do I have any doubts regarding the use of certain words?  
Did I take the time to check them?

	 9.	 Clarity and simplicity Is there any information that is missing? Is there too much 
information?

Are there sentences that are too long?

Will the reader understand all the words that I have used?

	10.	 Elegance and persuasion Is the language polite and proper?

Is my message elegant, inviting?

Speech Writing Checklist Reminder

Tip
To help you correct texts 
entered on a computer, do not 
hesitate to use the Spelling 
and Grammar function of 
Word or Antidote.

11
 Initiation to Producing  Reports

©
 S
O
F
A
D

 -
 R

e
p

ro
d

u
c

tio
n

 p
ro

h
ib

ite
d

.

460-714_Guide22_EN.indb   11 19-09-03   17:35



4623-01Printed in Québec

PRODUCING  
REPORTS

PRODUCING 
REPORTS

With the  learning guides, students acquire 
competency through authentic work situations so 
that they are ready to deal with the demands and 
needs of the labour market.

The Producing Reports learning guide is fully compliant 
with the vocational program in secretarial studies 
(DVS 5357) in the training sector of administration, 
commerce and computer technology.

As students perform the assigned tasks, they acquire 
elements of the competency Producing Reports:
• organizing work
• transcribing text
• laying out text
• inserting elements in documents
• generating tables of contents and indexes
•	 creating page layouts
• validating work
• publishing reports

The Producing Reports learning guide consists of three 
work situations:

	 Initiation to Producing Reports

	 Inserting and Laying Out All the Elements of a Report

	 Finalizing the Report

Discover our new  series: stimulating learning 
resources for contextualized training that promotes success 
both at school and in the workplace.

The learning guide and the answer key (PDF), as well as 
complementary digital resources, are available online at 
portailsofad.com.

960-714
LEARNING GUIDE

22

22
COMPETENCY

1
2
3

PRO
DU

CIN
G REPO

RTS

22

ISBN 978-2-89798-142-6

Secretarial 
Studies

A LEARNING GUIDE FROM  
THE COLLECTION

V
T 960

-714
Secretarial Studies

IN COMPLIANCEWITH THE NEWProgram of Study

Secretarial Studies

22 460-714 C1-epine-C4-ep3_EN.indd   All Pages 19-09-03   17:24




